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What is Net Nanny for Mac?

 Net Nanny is a content control program for the Macintosh, providing functions for parents 

and businesses. It is designed to filter and block certain Internet content according to the 

settings you choose. Net Nanny blocks adult web sites, sites with subjects not fit for children, 

and even blocks chats when predatory language is used. It blocks all offensive content coming 

from the Internet.

Net Nanny works with multiple users, and interfaces seamlessly with the Mac OS X user 

accounts on your computer. If you have several children, you can set different criteria 

corresponding to their age or maturity. You can choose whether they have access to 

newsgroups, e-mail, or whether they can download files. You can set the program to let them 

only use the Internet at certain times, and on certain days. You can choose to block or allow 

specific web sites, allow users only to use selected applications, and block access to specific types 

of content, such as streaming media or peer-to-peer file transfers. e program can even send 

you e-mail, automatically, when certain events occur.

You don’t let your children read just anything, do you? Well, without Net Nanny, they can see 

whatever they want on the Internet, unless you’re there to watch over their shoulders. With Net 

Nanny, the Internet is a safer place for your children.

Net Nanny sets up a protective wall around your computer. Its pre-defined filters let you 

choose what you don’t want your children to see, and you can create your own custom filters as 

well. Inappropriate web sites are blocked, shielding your children from content they are too 

young for. Additional filters block content by program type, such as chats, newsgroups and 

more.

Net Nanny keeps a complete log of all web sites visited, whether blocked or not, and records 

which applications have been blocked, if you choose to block certain programs. is gives you 
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a full record of your children’s activities on the Internet.Net Nanny makes the Internet a safer 

place for your children.

 Net Nanny is compatible with Mac OS X 10.4 Tiger, 10.3 Panther, and 10.2 Jaguar. It is 

compatible with Macs running either PowerPC or Intel processors.

 Net Nanny's Features

• Blocks and filters all offensive material from the Internet
• Customizable profiles—if you have several children, you can adjust the settings for 

their age and maturity
• Seamless interface with Mac OS X user accounts
• Multiple levels of protection
• Pre-determined filters for safe and easy content filtering
• Specific filters to block types of content, such as chats, streaming media and 

newsgroups
• Assistant simplifies user configuration
• Overview screen shows all user settings
• Blocks streaming media
• Blocks peer-to-peer software
• Blocks chats and e-mail
• Application blocking
• Start and stop time limits from the  menu
• Instant authorization for blocked sites
• Compatible with Intel-based Macs
• Automatic search engine redirection
• Limits Internet access by day and time

Chapter 1 – About Net Nanny 

Net Nanny for Mac User's Manual                      Page 7

 



• AntiPredator function to block predatory language in chat sessions
• Web site blocking—block or allow specific web sites
• Application blocking—block network access for all but selected applications
• Detailed logs of each user's Internet usage
• Traffic data recorded for an overview of Internet use
• Only authorized users can change program settings
• Automatic e-mail notification of certain events
• User manual in the Help menu
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A Brave New World

It’s a brave new world out there on the Internet: a world of information, entertainment and 

fun. You can surf the web for hours, going from news sites to sports sites, from movies to 

music, but, sooner or later, whether you like it or not, you will come across the dark underbelly 

of the Internet. For not all is as attractive as it seems. Sometimes you'll look for information in 

a search engine and come up with a list of links that seem to correspond to your search, when, 

in reality, some of them are pornography sites, others are hate sites, and some are propaganda 

for cults. 

You may be convinced that the Internet is the library of the future, and you may want your 

children to use it for their homework and entertainment, but do you really want them to see 

everything that's out there? You don’t let them read just anything, do you? Well, without Net 

Nanny, they can see whatever they want, unless you’re there to watch over their shoulders. 

e Internet is still young, and, from its earliest days, when it expanded beyond research 

laboratories and universities, it has been a kind of frontier land where anything goes. While this 

freedom is what gives the Internet its strength, it is also what makes it dangerous for children. 

Some people see the Internet as a huge library, newsstand and bookstore all in one. is is 

actually a good metaphor. But when you think about it, you don't give your children free rein 

in the library, nor do you let them look at every magazine you find on your local newsstand. 

e problem with the Internet is that its very nature, that of hypertext links from one site to 

another, means that content inappropriate for children is often just a mouse click away.

Types of Internet Content
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Children use the Internet for many purposes: to do their homework, to present creative 

writing, artwork or photos, to do research for school, to find out more about their favorite 

singers or movies, and to communicate with their friends, whether they be next door or in 

other countries. Many children have their own home pages, displaying their interests and 

hobbies, and others participate in chats with their peers around the world. 

In most cases, there is nothing dangerous about what they do, but many parents are concerned 

about the variety of subject matter seen on the Internet. Content presenting sexually explicit 

images, violence, gambling, alcohol advertising, ideological extremism, etc., is easily found, 

whether accidentally or on purpose. While parents consider it normal to protect their children 

from this content in books and magazines, and count on their local public libraries and schools 

to do so, there is no such protection on the Internet. 

Add to that the complication of the various national laws in the many countries accessible via 

the Internet—while national or local standards may exist in some areas, controlling such 

content, other areas may have no legislation at all. Gambling is legal in many countries, as is 

pornography; and, on the Internet, as we know, there are no borders.

Filtering Content

While adults have the right to free speech, many parents feel that their children should have the 

right to be protected from content that conflicts with their moral values. While freedom of 

expression does and should exist, there must be a way to protect children from content that is 

inappropriate for their age or maturity.

is inappropriate content can include web sites, chat rooms, newsgroups and even e-mail. It 

should be up to parents to decide which of the many Internet resources their children can 

access.
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e only solution to this problem is to filter Internet content with a program such as Net 

Nanny. is program allows you to choose the specific filters you wish to use and the level of 

filtering applied. You can also choose to allow your children to only access trusted sites that you 

add to the program, or only use specific applications, for the highest level of security.

How You Can Help Your Children Surf Responsibly

e best way to ensure that your children surf responsibly is to stand by their sides and help 

them choose what is right for them. But not all parents have the time for this, and it is essential 

to allow children to have a certain amount of freedom.Net Nanny helps by offering the 

possibility of filtering the content you want to protect your children from, or by allowing access 

only to trusted sites or specific applications. But Net Nanny also keeps a full log of your 

children's Internet sessions, so, if you want to give them freedom, you can check up on them 

afterwards. 
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Filtering Content in Businesses

While parents may want to protect their children by filtering Internet content, business 

managers may wish to do the same thing to protect their bottom line. e Internet gives their 

employees access to an endless source of information, but it also gives them plenty of chances 

to waste time. How many employees do their shopping on the Internet, play network games, 

send and receive personal e-mail or download MP3 files while at work, reducing productivity 

and using valuable network bandwidth?

Net Nanny can solve this problem by blocking access to many different types of sites, content 

and protocols, and contains specific filters for web sites designed for business use. 

Optimizing Productivity

e Internet can help improve employee productivity, by providing the latest information, but 

this productivity can drop sharply if employees spend their time playing games on the Net, 

checking sports scores or managing their investment portfolios. Also, your employees might be 

spending your time looking for a new job, consulting on-line job sites and sending résumés by 

e-mail.  Net Nanny helps you optimize productivity by blocking the sites you choose, such as 

shopping, financial or job sites. 

Optimizing Bandwidth

Your network bandwidth is valuable. Not only is it expensive, but when you need to send or 

receive large files, you need that bandwidth to be available. If your employees are wasting your 

bandwidth by downloading MP3 files, software or movies, you may find your network 

clogged.Net Nanny lets you block access to streaming media and peer-to-peer software, 
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conserving bandwidth and ensuring that your employees are not violating copyrights by 

downloading content illegally.

Protecting Your Company

If your employees spend their working time surfing sexually explicit sites, this not only reduces 

productivity, but it may even expose you to liability for sexual harassment. Sending private e-

mail over your mail server can also expose you to liability, and even prosecution, since your 

business is responsible for what circulates on its network. Net Nanny lets you selectively block 

access to different web site filters so your employees get down to business, all the time.
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System Requirements

• Any officially-supported Mac OS X compatible computer running a PowerPC or Intel 

processor
• Mac OS X 10.2.8 or higher
• 20 MB free hard disk space

Note: Net Nanny is compatible with Mac OS X 10.4 Tiger, 10.3 Panther, and 10.2 Jaguar.

Installing Net Nanny

If you downloaded the Net Nanny installer from the Internet, locate the disk image file that 

you downloaded. Double-click the folder corresponding to the language version that you want 

to install. en double-click the Net Nanny Install file. A window will display, offering you the 

options to Install or Uninstall: click Install. 
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If you bought a boxed version of Net Nanny, insert the CD in your computer. A window will 

now open. Double-click the folder corresponding to the language version that you want to 

install. en double-click the Net Nanny Software Install icon. A window will open advising 

you that you will need a serial number to install the software or that you can install a demo 

version without a serial number. Click OK. Select Install in the Net Nanny popup menu. A 

green arrow will then display on the Net Nanny icon, indicating that you have chosen to install 

this software. Click the Launch Installation… button.

You will need to enter an administrator’s password to install Net Nanny on your computer. 

Click Continue to proceed with installation. e software license displays. Click Continue, 

then click Agree if you accept this license; if not, click Disagree, and the installer will quit.
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e next window shows all the available disks or volumes on your computer. Select the disk or 

volume where you want to install Net Nanny, then click Continue.

Click Install to install Net Nanny, or click Upgrade if you have already installed other  

software. After installation, you will have to restart your computer.
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Serializing Net Nanny

After you restart your computer, open Net Nanny—it is found in your Applications folder. Net 

Nanny displays the following window:

Since Mac OS X is a multi-user operating system, not all users have the same privileges. When 

starting up Net Nanny for the first time, any user can enter the serial number, but only a user 

with administrator privileges can configure the program. 

You must enter your name, company, if any, and your serial number. If you purchased a boxed 

version, the serial number is found on a sticker inside the DVD case. If you purchased a 

downloadable version, your serial number was sent to you in your e-mail confirmation. When 

you have entered your information, click OK. When serialization is completed, Net Nanny will 

open, and, if you are an administrator, you can configure the program.
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4 – Using Net Nanny 
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First Launch of Net Nanny

 Net Nanny is installed in your Macintosh’s Applications folder. To open Net Nanny, go to this 

folder then double-click the Net Nanny application icon.

e first time you launch Net Nanny, the Net Nanny Assistant displays:

is assistant walks you through the configuration process, and explains the types of content 

that Net Nanny filters, and how this filtering is done. Click Continue to start configuring your 

Chapter 4 – Using Net Nanny 

Net Nanny for Mac User's Manual                                 Page 22



users. If, at any time, you wish to return to a previous screen, click the Go Back button to do 

so.
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Setting an Administrator Password

e second screen of the Net Nanny Assistant asks you to set an administrator password for 

Net Nanny. 

You always need an administrator password to change Net Nanny’s settings. is prevents your 

users from accessing and changing their own settings.Net Nanny gives you two options: you 

can use your Mac OS X administrator password, or you can set a special Net Nanny 

administrator password.

e advantage to using a Mac OS X administrator password is that any user with administrator 

access to the protected Mac will be able to make changes to Net Nanny’s settings. Since you 
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can have several user accounts with administrator access under Mac OS X, this allows you to 

ensure that, in certain environments such as schools, an administrator who can access and 

change Net Nanny’s settings is always available.

If you are using Net Nanny on a home computer, you may only have one administrator. In this 

case you can also use the Mac OS X administrator password. However, if you want extra 

security, or if you want to limit the ability to make changes to Net Nanny’s settings to specific 

administrators, you can set a special Net Nanny password. To do this, check Use Net Nanny 

password, then click Change Password. 

In the window that displays, enter a password, enter it again in the Verify field, then enter a 

hint to remind you of the password in the Hint field. Click Set to set this password as the Net 

Nanny administrator password.

Click Continue to go to the next screen, or click Go Back to return to the previous screen.

User Selection
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e next screen of the assistant lets you select which user you wish to configure. is screen 

shows all the users you have on your Mac, and what type of accounts they have. 

ere are two types of user accounts: administrators and standard users. is screen shows you 

the name of each user and the type of account they have. In the above example, Alice is an 

administrator, and Paul is a standard user.

If you have set a special Net Nanny password, even users who are administrators will not be 

able to make changes to Net Nanny’s settings. If not, then any user with an administrator 

account will be able to access Net Nanny and change settings for their account or for other 

users. While the Net Nanny password prevents administrators from changing the program’s 

settings, any user who is an administrator will be able to uninstall the program. erefore, if 
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you have not set a special Net Nanny password, it is best to use standard accounts for users for 

whom you wish to filter content.

If you need to make changes to any user accounts, such as adding or removing administrator 

privileges, or if you wish to add, edit or remove any user accounts, click Open Accounts; this 

opens the Accounts preference pane. For more on managing user accounts, see the Mac OS X 

help.

To configure a user, click their name to select them, then click Continue.
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User Profile Selection

Net Nanny lets you choose from three default profiles, and also lets you create custom profiles 

to filter the exact types of content you want, according to the age and maturity of your users. 

All users initially have a Restricted access profile, and each new user account you add to your 

computer inherits this profile as well, unless you change their settings in Net Nanny. 

e Restricted access profile provides the following protection: Web, Chat and E-mail are 

filtered using a set of pre-defined categories, and Streaming, Peer-to-Peer and Newsgroup 

applications are blocked.

e following describes the different types of filtering that Net Nanny performs:
• Web: Net Nanny can filter web sites accessed via a web browser (such as Safari) or other 

applications that use the same protocol to access and display web content.
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• Chat: Chat applications, such as iChat, MSN Messenger, AIM and ICQ can be 

blocked or filtered.
• E-mail: Net Nanny can filter both incoming and outgoing e-mails, looking for content 

in the various categories it uses.
• Streaming: Streaming media is music or video that is provided live, as opposed to 

being downloaded. is includes applications such as iTunes, Real Player, Windows 

Media Player and others. Streaming does not, however, filter downloads of music or 

video files; Net Nanny’s web filtering can block these categories.
• Peer-to-peer: is type of application allows users to share files of all types, and may be 

used for trading files illegally.Net Nanny can filter all peer-to-peer applications.
• Newsgroups: ese are discussion groups whose access requires specific applications. 

However, newsgroup application filtering does not affect user access of newsgroups 

through web pages. Net Nanny’s web filtering categories can block or filter newsgroups 

viewed via web pages.

In addition to this Restricted access profile, three other profiles are available:

• No restrictions: Users have unrestricted access to all types of content, applications, 

and unlimited network access.
• No access: Users have no network access.
• Custom: You set the restrictions you want for the user. 

If you choose Restricted access, No restrictions or No access for the selected user, click 

Continue to apply these settings. If you wish to apply custom settings for your user, see the 

next section for more on creating custom profiles.
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Creating Custom Profiles

If, on the previous screen, you chose Custom for your user, you will now see a series of screens 

that allow you to configure custom settings for that user. If you have selected any of the default 

profiles, you will not see these screens, and you can skip ahead to the Apply Settings section.

Web Filter Setup

is screen lets you choose which categories Net Nanny uses to filter web content (as well as e-

mail and chat content).

Initially, all categories are set to be blocked. To allow access to specific categories, click the red 

Stop icon to the right of a category name; it changes to a green Go icon, showing that its 

content is now allowed.
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You can also create your own custom categories; see later in this manual, Adding Custom 

Categories, for more on creating custom categories.

When you have chosen which categories you wish to allow, click Continue to go to the next 

screen.
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Chat Filter Setup

is screen lets you decide which chat filter settings you wish to use.

ree options are available:
• Allow Chat: is lets users chat with no restrictions.
• Allow Chat with AntiPredator enabled: is lets users chat, but enables Net Nanny’s 

AntiPredator function, which filters predatory language in chat sessions.
• Block Chat: is prevents users from accessing any chat applications.

When you have selected chat filter settings, click Continue to go to the next screen.
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Miscellaneous Filter Setup

is screen lets you set up Net Nanny’s other filters: E-mail, Streaming, Peer-to-Peer and 

Newsgroups.

Choose whether you want to allow e-mail, block e-mail, or filter e-mail using the web 

categories you set up earlier.

Choose whether you want to block streaming content; to allow streaming content, uncheck 

Block Streaming content.

Choose whether you want to allow Peer-to-Peer content; to allow Peer-to-Peer content, 

uncheck Block Peer-to-Peer.
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Finally, choose whether you want to allow newsgroup access; to allow newsgroup access, 

uncheck Block Newsgroups.

Click Continue to move on to the Apply Settings screen.
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Apply Settings

If you chose Restricted access, No restriction or No access for a user, then clicked Continue, 

the following screen displays next; if you chose Custom, then this screen displays after the three 

Filter settings screens:

If you wish to apply the settings you just selected to other users, check Apply those settings to 

these users, then click one of their names to select them, then click Continue. (You can hold 

down the Command key and click several users to select them.)

Extra User(s)
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e next screen asks if you want to continue setting up other users, or if you have finished 

setting up users and want to move on to the next step.

If you wish to continue setting up other users, select the first option, then click Continue. If 

not, select Move on to the next step and click Continue.
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Reporting

When you have finished setting up all your users, the Reporting screen lets you choose global 

reporting options for Net Nanny.

Net Nanny can send you e-mail notifications of certain events, such as AntiPredator alerts (if 

predatory language is detected in chat sessions or e-mails), and can also automatically send user 

logs to a specific e-mail address at the frequency you choose.

To activate AntiPredator notifications, check this option. To have Net Nanny send log reports, 

check this option, then choose whether you want logs sent every n hours, weeks or months. 

Enter a number, then select Hours, Weeks or Months from the popup menu. By default ,Net 

Nanny sends full logs of all access and events, but if you only want a log showing which web 

sites and applications have been blocked, check Report only blocked accesses.
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To enter the e-mail address to which Net Nanny sends these alerts and logs, click E-mail 

Settings. A sheet displays where you can enter the necessary information for your sender’s 

name, e-mail address, and more.

Enter a sender’s name, then enter one or more recipient e-mail addresses. To add addresses, 

click +, then type an e-mail address. To delete any e-mail addresses, select them and click –. 

You must also enter your outgoing mail server; if you don’t know this, check the settings in 

your e-mail program, or ask your ISP or your computer’s administrator. Finally, if your e-mail 

account uses some form of authentication, select the authentication method, and enter your 

user name and password. Only enter authentication information if you are sure that your e-

mail account requires it. Again, check your e-mail program to see if you have authentication 

set, or contact your ISP or administrator.
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Click OK to save these e-mail settings, then click Continue to go to the next screen.
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Finishing Up

e final screen, Congratulations!, informs you that your settings will be applied, and that the 

main Net Nanny interface will now display.

Click Done to complete your configuration.

If you wish to reconfigure your users, or configure new users with the Assistant, you can do so 

at any time by selecting Assistant from the Net Nanny menu when the program is running.
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Managing Users

You have seen that you can use the Net Nanny Assistant to set up and configure your users. 

You can also make changes to these configurations from the main Net Nanny window. 

When you display the Net Nanny window, you see, at the left, a list of your users. If you click a 

user to select them, the right-hand side of the Net Nanny window shows you which settings are 

applied to them.

Changing User Display
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Net Nanny displays users by default as silhouettes with large icons in the left-hand column of 

the program’s window. You can change this display, customizing each user’s image, name and 

more.

If you click the Action button at the bottom of the user list, you can choose to display small 

user icons and/or full names. Select either of these options to change the display.

Selecting small user icons is practical if you have many users, and using full names is helpful if 

you have several users with the same first name.

You can also make these changes from the View menu: select View, then select Use Small User 

Icons or Show Full Name.

You can also apply a profile quickly to a selected user from this menu. You can select from the 

default profiles, No restrictions, Restricted access, No access, or you can select Custom to 

adjust settings manually. Just select the profile you want to apply, and the selected user’s settings 

will change.
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Saving User Profiles

If you create a customized profile for one of your users, you may want to apply the same profile 

to other users. After choosing all the filters and settings you want to apply, you can export a 

profile to save it, then import it to apply it to another user.

To do this, apply all the settings and filters you want to a user. Make sure you have selected that 

user in the Net Nanny Users list, then select File > Export Profile…

Give the profile a name and save it wherever you want.

If you wish to apply this profile to another user, click the user's name in the Users list, then 

select File > Import profile... Locate the saved profile in the Open dialog that displays, then 

click OK. All the settings contained in this profile are applied to the selected user. You can 
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make changes to this user's settings, modifying the settings you imported from the saved 

profile, but these changes will not affect the saved profile. 
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Editing User Information

Net Nanny allows you to change some user information, which may facilitate user 

administration, especially for large groups of users. You can add users’ last names, you can 

change the colors and silhouettes that display, and you can even add photos of your users.

To edit this information, click on a user in the Users list. e top section of the Net Nanny 

window shows you information about this user.

To edit user information, click the Edit button. 

You can enter the user’s first and last names (the user’s name that displays in the Users column 

in taken from the name of the user account in Mac OS X). You can change the background 

color—the default color is light gray, but you can change this to blue (Boy) or pink (Girl). 

You can also change the silhouette that displays for the user by clicking on the silhouette in the 

Edit section.
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Select one of the default silhouettes, or select Edit Picture to add a photo of the user.
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Drag an image file to the image well, or click Choose to browse and find a photo. If you have 

an iSight or other camera, you can plug it in and take a video snapshot. When you have added 

your picture, click Set to apply it, then click Save to save the changes you have made to your 

user’s information.
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The Net Nanny Overview Screen

Net Nanny provides an Overview screen which, for each user, displays a summary of their 

settings and a usage report.
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is screen displays whenever you launch Net Nanny, or whenever you click on a user in the 

Users list. It shows you the following:

• User information: At the top of the screen, you see the user’s name, profile and 

reporting options. You also see a silhouette for the user, or a photo, if you have set one.
• Filter settings: e middle section shows the current settings for each of Net Nanny’s 

filters. A round, colored icon at the bottom right of each filter icon gives you 

information on the type of filtering: green means there are no restrictions, orange 

means there are some restrictions, and red means there is no access. Texts next to each 

filter icon give you more information about each filter and its settings.
• Usage report: e bottom section shows a usage report for the user: their last Internet 

connection, how many web pages they have visited and how many have been blocked, 

and the types of content that have been blocked.

You can also access the log for the user by clicking the Log button. For more on logs, see Using 

Logs later in this manual.
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Custom User Profiles

In addition to Net Nanny’s default profiles, the program allows you to customize user settings, 

to fine-tune the filters, schedule and other elements. You have already seen custom profiles in 

the Net Nanny assistant, but the program allows you to refine these profiles even more than 

what is available from the assistant. You can change any or all of the following for each user:

• Web: Net Nanny comes with a set of predefined filters for different categories of 

web content. You can choose which of these filters are applied in your profiles, and 

you can also add your own custom filters.
• Blocked and filtered site redirection: You can choose to redirect all blocked and 

filtered sites to the page of your choice.
• Search engine redirection: You can choose to redirect all search engine requests to 

the search engine of your choice.
• Special web site settings: Net Nanny allows you to add specific sites that are 

always allowed or blocked, regardless of your filtering settings.
• Chat: Net Nanny can block the use of any chat or instant messaging software, such 

as iChat, AIM, MSN Messenger, ICQ or others.Net Nanny blocks chat software by 

protocol, so it acts on any type of instant messaging software.
• AntiPredator: You can choose whether or not you wish to activate Net Nanny’s 

AntiPredator function, which filters predatory content in chat rooms or instant 

messaging applications.
• E-mail: As for web content, Net Nanny comes with a set of predefined filters for 

different categories of content sent and received by e-mail. You can choose which of 

these filters are applied in your profiles, and you can also add your own custom 

filters.
• Streaming: Net Nanny can block all kinds of streaming media—music or video 

delivered from web sites.
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• Peer-to-peer: You can block the use of peer-to-peer software, which is used to 

exchange files, often illegally.
• Newsgroups: Net Nanny can block access to newsgroups and their content.
• Applications: You can choose to only allow users to use specific applications to 

access a network.
• Schedule: You can choose when a specific user can access the Internet, by day and 

time, and apply time limits.
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Defining Content Settings

As mentioned above Net Nanny lets you define settings for many elements that determine how 

users can interact with the Internet and what type of content they can access. To apply custom 

settings for any user, click on a user in the Users column, then click the Profile menu popup 

menu below their name.

Select Custom from this menu. 

You will now be able to access all of Net Nanny’s settings for that user.

When you have set a user to a Custom profile, the Net Nanny interface changes, showing 

several buttons above its overview screen.

If you hover your cursor over these buttons, they become active:
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You can then click them to access the different screens that allow you to adjust custom profile 

settings.

You can also move your cursor over any of the settings zones in the Overview screen:

ese, too, become active (you can see that they become a darker gray), and clicking any of 

them takes you to the screen where you adjust the specific settings for that type of content. 

You can return to the Overview screen at any time by clicking the Overview button.
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Filters

Net Nanny offers a comprehensive set of filters that you can activate or deactivate by type, if 

you apply a custom profile to any of your users. Some of these filters simply block or allow 

specific types of content or network access, and others, arranged in categories, allow you to 

decide what type of content to block or allow more precisely. To access Net Nanny’s filters, 

click a user, whose profile must be custom, then click the Filter button.

e Mode popup menu offers two Web filtering options: Filter Access by Categories, which is 

the default option, or Restrict to Specific Web sites.
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Filtering Web Access by Categories

Using Net Nanny’s category-based web filtering gives you thorough protection from 

undesirable content on the Internet. You can also fine-tune this protection by choosing which 

filtering categories are active, and you can create your own custom filters.

When you set a user’s profile to Custom for the first time, web filtering is active, and all of Net 

Nanny's filters are active, blocking the content they filter. e red Stop icons indicate this. To 

deactivate a filter, click its icon; it will change to a green Go icon, showing that it now allows 

the user to access content in this category.

To block access again to a given category, click the green Go icon; it will change to a red Stop 

icon.

You can also click a category while holding down the Control key, then choose Block or Allow 

from the contextual menu that displays to change the filter’s behavior.
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To deactivate web filtering, uncheck the box next to Web. e Net Nanny interface changes 

and you can no longer customize web filtering settings.
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Adding Custom Categories

In addition to its predefined categories, Net Nanny allows you to create your own custom 

categories. To do this, click the + button.

e Custom Category sheet displays.

Enter a name for your category in the Name field.
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en click the + button to add a keyword to your category. is can be a single word or a 

phrase.

You can enter as many keywords as you want—click Add again to add another keyword, and 

enter another text.

If you wish to remove a keyword, click it to select it, then click the – button. 

After you have added as many keywords as you want to your filter, click OK to save the 

category, or click Cancel to cancel the operation. Your custom categories appear at the top of 

the filter list. ey are shown in bold type. 
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You can activate or deactivate any of your custom filters by clicking their icons or by selecting 

them and blocking or allowing their content using the Action button, as described above.
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Editing Custom Categories

To edit any of your custom categories, click one of your filters to select it, then click the Edit 

button.

e Custom Category sheet appears. Make any changes you wish, as described above, then 

click OK to save the changes, or click Cancel to leave the filter as it was.

Deleting Custom Categories

To delete any of your custom categories, click one of your categories to select it, then click the 

– button, or press the Delete key.

An alert displays, asking if you are sure you want to delete this custom category. Click Remove 

to delete it, or click Cancel to keep it.
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Using Web site Exceptions 

In addition to using Net Nanny’s built-in filtering categories, as described above, you can also 

restrict user access to certain web sites. You can add specific sites that are always allowed, and 

others that are always blocked. (You also have the option to only allow web access to certain 

sites; see Restricting Web site Access below for more on this option.)

To access the Web site exceptions pane, click the Exceptions button:

e Web site exceptions pane displays:
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Adding Web site Exceptions

You can add sites to this pane by clicking the + button. A sample web site name displays when 

you do this:

Enter the URL, or web address, of a site in the text field then click OK. By default, new sites 

you add are blocked, no matter what type of content they contain. Click the red Stop icon to 

change it to a green Go icon and allow access to the site; even if you have set filters for specific 

content that appears on this site, users will be able to access it.

You can add as many sites as you want to this list. is is useful if, for some reason, one of Net 

Nanny’s filters blocks a site that you want to allow a user to access, or if it does not block 

certain sites that you don’t want your user to see.

Removing Web site Exceptions

To remove sites you have added to the web site exceptions list, select a site then click the – 

button or press the Delete key. An alert displays, asking if you are sure you want to delete this 

custom category. Click Remove to delete it, or click Cancel to keep it.
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Restricting Web site Access

In addition to using Net Nanny’s built-in categories and web site exceptions, you can limit web 

site access to only those sites you choose. To do this, select Restrict to Specific Web sites from 

the Mode popup menu.

Choosing this mode limits your user to only those web sites you add to the list. 

Adding Web sites to the Restricted List

You can add sites to this list by clicking the + button. A sample web site name displays when 

you do this:

Enter the URL, or web address, of a site in the text field then press Return. You can add as 

many sites as you want to this list.

Removing Web sites from the Restricted List

To remove sites you have added to the restricted list, select a site then click the – button or 

press the Delete key. An alert displays, asking if you are sure you want to delete this custom 

category. Click Remove to delete it, or click Cancel to keep it.
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Redirecting Blocked and Filtered Sites

When Net Nanny's filters block access to web pages, or when a user attempts to view sites that 

are listed in the Blocked Sites tab, the program displays a warning in their browser, saying that 

Net Nanny has blocked the page. 

You can also choose to redirect blocked pages to the Yahooligans web site, or, if you wish, you 

can redirect blocked and filtered sites to the web page of your choice. 
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If you wish to redirect these sites to another page, such as your home page, or a special page on 

an internal network, click the popup menu, and select Edit… Click the + button, enter a new 

web page, then click Close.

If the web page that Net Nanny has blocked is not offensive, you can click the Allow this web 

site link to add it to the list of trusted sites. An alert displays, where you see the URL that was 

blocked, and where you must enter your Net Nanny administrator’s password.
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Click Unlock to allow the web site, or click Cancel to close this window and continue to block 

this web site.
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Using Search Engine Redirection 

Net Nanny allows you to redirect Internet searches to the search engine of your choice. If a user 

enters the name of a search engine, such as Google, Yahoo!, AltaVista, Excite, etc., in their web 

browser, and you have activated this function, their search will be redirected to the search 

engine you have chosen. ese settings are made on the Filters pane.

By default, search engine redirection is not active.

To activate search engine redirection, select a search engine from the popup menu.Net Nanny 

includes menu items for family-friendly search engines for this redirection. 

Adding Redirection Sites

You can also add your own search engines to the Redirection menu. To do this, select Edit... 

from the popup menu. Click the + button, enter a new web page, then click Close.

Removing Redirection Sites

To remove a redirection site, select Edit... from one of the redirection popup menus. e 

Redirection Site sheet displays. Click one of the redirection sites to select it, then click the – 

button to remove it. Click Close to close the Redirection Site sheet.

Chat Filtering
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Net Nanny lets you filter or block chat sessions, and offers a powerful function to protect your 

children when in web chat rooms or when using chat programs, such as IRC chat software or 

iChat, ICQ or AIM instant messaging software. e AntiPredator function filters chat texts for 

predatory language, that is, language asking for personal information about the user. is 

includes such questions as, "are you home alone", "what is your phone number", as well as 

other key words and phrases that might indicate predatory behavior by other users.

To turn on chat filtering, check the Chat box in the Filter list.

Chat filtering offers two modes: AntiPredator, and Blocked. Choose one of these modes from 

the Mode menu.

If you choose Blocked, the user will not be able to use any chat software. If you choose 

AntiPredator, the AntiPredator function is active, protecting your users from predatory 

language.

Displaying Filters

Chapter 4 – Using Net Nanny 

Net Nanny for Mac User's Manual                                 Page 69



Net Nanny's AntiPredator comes with a set of basic text strings as filters for incoming data, and 

several languages are available. You can choose to display all filters, filters in a specific language, 

or just custom filters that you add to the list. To do this, select which filters to display from the 

Action popup menu.

By default, all the AntiPredator phrases are active when you turn on chat filtering. You can 

disable any of them if you wish by unchecking them, or by selecting them and clicking the 

Action menu and selecting Disable.
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Adding Filters

While Net Nanny contains an extensive list of text strings to be filtered, each of these tabs 

provides an area where you can add your own words and phrases. You could add, for example, 

your address or phone number, as well as any other personal information you feel should be 

protected.

To add a filter for either Incoming or Outgoing data, click the + button. A new line displays at 

the bottom of the filter list. Enter the Enter the word, phrase or sentence you wish to filter; it 

must be at least 4 characters..

Click the menu in the Kind column and select whether you want this text to be filtered for 

incoming chats, outgoing chats or both.

NOTE: it is best to filter the shortest possible texts.Net Nanny looks for the exact text you 

have entered in the filter, and, if the user types it differently, it will not be blocked. For 

example, rather than enter "my phone number is 555-1999", it is best to enter just the phone 

number.
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Editing Filters

To change the text of any of your filters, just click the entry to select it, then edit it. 

You can change any of your filters at any time. When you have finished, just press Enter.

Deleting Filters

To delete any of your filters, click one of them in the filter list to select it, then click the –

button. An alert displays, asking if you are sure you want to remove the filter. Click Remove to 

delete it, or click Cancel to keep it.
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E-mail Filtering

Net Nanny allows you to apply its built-in content filters to e-mail messages as well as web 

pages. To activate e-mail filtering for a selected user, check the E-mail box in the Filter list.

E-mail filtering offers two modes: Filter by categories, and Blocked. Choose one of these modes 

from the Mode menu.

If you activate e-mail filtering and select Filter by categories, Net Nanny monitors incoming e-

mail. If any message is found containing content in one of the active filters, Net Nanny blocks 

the connection with the mail server. In this case, no mail can be received. 

To unblock e-mail, an administrator must change the user's profile and turn off e-mail filtering 

to be able to receive e-mail waiting on their mail server. 

If you select Blocked mode, all e-mail access is blocked.

Chapter 4 – Using Net Nanny 

Net Nanny for Mac User's Manual                                 Page 73



Streaming Filtering

Net Nanny can filter streaming audio and video, which is audio or video content that is played 

back live, rather than after downloading. To activate streaming filtering for a selected user, 

check the Streaming box in the Filter list.

ere are no options for streaming filtering; it is either active or inactive.

Peer-to-Peer Filtering

Net Nanny can filter peer-to-peer software, which is often used to share files over the Internet. 

To activate streaming filtering for a selected user, check the Peer-to-Peer box in the Filter list.

ere are no options for peer-to-peer filtering; it is either active or inactive.
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Newsgroup Filtering

Net Nanny can filter newsgroups, which offer discussion forums using a specific protocol and 

specific software. To activate newsgroup filtering for a selected user, check the Newsgroups box 

in the Filter list.

ere are no options for newsgroup filtering; it is either active or inactive.
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Application Filtering

Net Nanny gives you the option of only allowing users to access the Internet with specific 

applications. Rather than filter web access by category, for example, you can prevent a user 

from using any web browser. You can choose which applications can access the Internet; all 

other applications are blocked. To set up application filtering, click the Applications button on 

the Net Nanny button bar.
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If you use application filtering, this supercedes all other Net Nanny filtering rules: if, for 

example, you do not add a web browser to the application list, then web filtering will have no 

effect. However, Net Nanny’s other filtering rules apply to all applications added to this list. So 

if you choose to allow a user to access the Internet with a web browser, then Net Nanny’s active 

web filtering categories will filter web sites visited.

To use application filtering, check is user can only access the Internet with these 

applications, then click the + button and navigate to your Applications folder to add 

applications. You can also drag applications from a Finder window into this list. As you add 

applications, they display in the list.

To remove an application from the list, click it to select it, then click the – button. An alert 

displays, asking if you are sure you want to remove the application. Click Remove to delete it, 

or click Cancel to keep it.

If, at any time, you want to stop using application filtering for a given user, simply select their 

name in the User list, click the Applications button, then uncheck is user can only access the 

Internet with these applications.

Application Alerts
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If Net Nanny is set to only allow Internet access via certain applications, the program blocks 

any attempt to connect to the Internet by other applications that are not in the application list. 

By default, Net Nanny does nothing other than block this access; users do not see any alerts. 

However, you can turn on alerts so users understand why this access is blocked.

To do this, select Net Nanny > Preferences, then click the Reporting tab. 

Check Display an alert when access is blocked, and Net Nanny will display an alert like this:
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Check OK to dismiss the alert. Note that in some cases, as above, Net Nanny will display 

multiple alerts—this is because some applications make several requests when connecting to 

the Internet. If this occurs, you can either click Next to see each alert, or check Close all 

opened alerts, then click Next to close the alert window. If you want to know more about the 

reason for the alert, click the disclosure triangle next to the word Details to toggle an additional 

information section.
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Using Schedules

Net Nanny lets you set a schedule for each of your users, either individually, or as part of a 

custom user profile. You can offer users unlimited Internet access, or only allow them to access 

the Internet on certain days and during certain periods. Under the No restrictions and 

Restricted access profiles, users have access to the Internet at all times; under the No access 

profile, they have no Internet access. If you wish to set a schedule for a user, you must select the 

Custom profile.

To access schedule settings, click the Schedule button in the Net Nanny button bar.
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Setting Time Restrictions 

If you select the Custom profile for a user, you can use the timetable to set time restrictions. By 

default, under this profile, the user is granted access to the Internet at all times. 

When you first see the timetable, all the cells are green: this represents periods in which users 

have Internet access. To block Internet access at given times, click the time cells in the 

timetable—each cell represents one hour. You can click individual cells, or you can click the 

mouse button and drag it to cover longer periods. 

As you click cells, tooltips display showing the periods that you are enabling or disabling. You 

can allow or forbid access for any hour-long period on any day of the week in this manner.

If you wish to allow or forbid access to an entire day, or if you simply want to reset access for a 

day to change settings from scratch, you can click the name of a day. is resets the entire day 

to green, or allows access for that day. Click again to block access for that day.
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You can also click and drag in any direction to change cells. If, for example, you start clicking 

on the green cell at the top left, and drag to the bottom right, a section of green cells becomes 

pink.

If a user attempts to connect to the Internet using a web browser during a time period when 

access is not allowed, they will see an alert:
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However, if users attempt to connect to the Internet with other applications, they may not see 

an alert; in some cases, their access will simply be blocked. Some applications will display their 

own alerts, saying that they could not connect to the Internet.
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Setting Time Limits 

Within the time restrictions you set using the timetable, you can also set time limits. Say you 

want to allow a given user to access the Internet only between noon and 6 pm, but you only 

want them to be able to do so for one hour a day. First apply the time restriction, as explained 

above. en, move the cursor over one of the days on the timetable, on the green part, hold 

down the Control key, and click. 

Select Add Time Limit… A dialog displays.

Select the time limit by dragging the slider to change the number of hours, then click OK.
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e time limit is applied, and the timetable display changes to show this limit: the section 

containing the time limit contains green and white stripes, and a clock icon and text show the 

length of the time limit applied.
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Editing Time Limits

To change the amount of time available in a time limit, move the cursor over one of the 

sections with a time limit, hold down the Control key, and click. Select Edit Time Limit… 

from the menu. 

A dialog displays. is is the same dialog you used to set the time limit. You can change the 

time limit here by dragging the slider. Click OK to save your changes, or click Cancel to keep 

the previous time limit.

Removing Time Limits

To remove a time limit, move the cursor over one of the sections with a time limit, hold down 

the Control key, and click. Select Remove Time Limit from the menu. e time limit is 

removed.
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Using Logs 

Net Nanny provides a complete log of all Internet activity for each user. To view the log, click 

the Logs button on the Net Nanny button bar.

e Log shows a record of Internet activity for the selected user. Click on a user in the Users 

column to see their log.

Types of Log Reports

Net Nanny lets you choose from four types of reports when you view logs. ey are:
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• Simple Report: is shows web sites that the user has visited, along with those that 

Net Nanny has blocked, and also shows any applications that have been blocked. When 

viewing Simple reports, web sites visited are grouped: if a user visits several pages at a 

given site, the report shows the site name and the number of pages visited. In addition, 

the Simple report shows how many of those pages, if any, were blocked.
• Complete Report: is shows all Net Nanny activity, including web sites that the user 

has visited, those that Net Nanny has blocked, trusted web sites that have been visited, 

applications that have been blocked, and any times that Net Nanny has been launched 

or quit.
• Blocked Accesses: is only shows web sites or applications that Net Nanny has 

blocked.
• Blocked Applications: is only shows applications that Net Nanny has blocked.

To choose which type of report you wish to view, click the Show menu and select one of the 

above report types.
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Understanding the Log

Each Log entry contains four different items of information: a colored icon, the Date and 

Time, the Event and Information.

• Icon: See below for a description of the different icons.
• Date & Time: is is the date and time that the user accessed or tried to access the web 

page or application.
• Event: is shows whether the user accessed a web site, or whether it was blocked, 

filtered or redirected. is also shows application activity, such as applications that are 

blocked, or launching or quitting Net Nanny.
• Information: is is the web site address of the server the user accessed or tried to 

access, or the name of the application that was blocked.
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Status Icons

ree icons may appear in the log. 

• Green: Green icons show visited sites or application activity, such as launching or 

quitting Net Nanny.
• Orange: Orange icons indicate sites that have been blocked by Net Nanny's filters for 

their content or URLs. Orange icons only display when you are viewing a simple 

report; they indicate that one page of several visited at a given web site has been 

blocked.
• Red: Red icons indicate sites that have been blocked, or sites that the user did not have 

the right to access in the schedule at that time. 
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Accessing Sites in the Log

If you want to check any of the sites listed in the log, you can access them by simply double-

clicking one of the log entries. is will cause the appropriate program to open (if your 

Internet settings are correctly set) and connect to the site. Sometimes, however, you will find a 

page that displays nothing, or displays an error message. is is because some of the URLs in 

the log may be links to graphics or other elements on web pages. 

If you are viewing a Simple report, double-clicking a web site takes you to the main page for 

that site. In the Complete report, or when viewing Blocked Accesses, double-clicking a web site 

will take you to the exact pages that were visited or blocked.

Blocking or Allowing Sites from the Log

When viewing logs, you can block or allow web sites that display in the log. Hold down the 

Control key and click on a log entry. Select Block or Allow, from the contextual menu that 

displays, and Net Nanny adds that site to the list of blocked or allowed sites.
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Sorting the Log 

e log can be sorted by any of its fields by clicking on the header just above the field. 

It can also be sorted in ascending or descending order by clicking on the sort button, the small 

triangle in the selected sort column header.

Clearing the Log

To clear the log, and erase all information stored in the log, for all users, click the Action 

button at the bottom of the window and select Clear Logs (for all users)… An alert displays, 

asking if you are sure you want to clear the log. Click Clear to delete it, or click Cancel to keep 

it.
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Exporting the Log

You can export Net Nanny logs to view them later, or in other applications, such as text 

editors, word processors, or web browsers. You can export logs in two formats: text and 

HTML. If you select text, they will be saved in a file that can be read by any word processor. If 

you select HTML, their files will be readable by any web browser, and will be presented in table 

form. 

To export logs for all users, click the Action button at the bottom of the window and select 

Export Logs. A sheet displays where you choose a name for the log, a location to save the file, 

and the format, either text or HTML. 

Click Export to save the log in the selected format.
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About Net Nanny

If you select About Net Nanny from the Net Nanny menu, the About... window gives 

information about Net Nanny, such as the version number, your support number (a number 

you need for technical support), and a clickable link that creates an e-mail message to ’s 

technical support.
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5 - Technical Support
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Technical support is available for registered purchasers of Net Nanny.

By e-mail support@netnanny.com

By phone: 1-800-485-4008

Toll-free live support offered Monday – Friday 8AM to 5PM Mountain Time

From the web site

www.netnanny.com
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6 - Glossary
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Chat: A system that allows two or more logged-in users to set up a typed, real-time, on-line 

conversation across a network.

DNS: Domain Name System. Used by routers on the Internet to translate addresses from their 

named forms, such as www. .com, to their IP numbers.

FTP: File Transfer Protocol. A protocol used for transferring files from one server to another. 

Files are transferred using a special program designed for this protocol, or a web browser.

HTTP: HyperText Transfer Protocol, the protocol used to send and receive information across 

the World Wide Web.

ICQ: A popular program used for on-line chats.

IP: e network layer for the TCP/IP protocol suite widely used on Ethernet networks and on 

the Internet. 

IP address: An address for a computer using the Internet Protocol. 

IRC: Internet Relay Chat. A medium for worldwide "party line" networks that allows people 

to converse with others in real time.

Local network: A network of computers linked together in a local area. is may be a single 

building, site or campus. 

Network: A group of interconnected computers that can all access each other, or certain 

computers. is may be a local network, or a very large network, such as the Internet.

Newsgroup: A type of discussion group that uses a special protocol (NNTP) and special 

software. ere are several tens of thousands of newsgroups, each dealing with very specific 

subjects. To access this kind of content, you need special software, but some web browsers 

include a newsgroup reader.

NNTP: Network News Transfer Protocol. A protocol for the distribution, inquiry, retrieval and 

posting of newsgroup articles over the Internet.

Protocol: e set of rules that govern exchanges between computers over a network. ere are 

many protocols, such as IP, HTTP, FTP, NNTP, etc.

Server: A computer connected to a network that is serving, or providing data or files to other 

computers called clients.
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TCP: Transmission Control Protocol. e most common data transfer protocol used on 

Ethernet and the Internet

TCP/IP: e Internet version of TCP; TCP over IP.
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